
Title
Optional Subtitle





Title
Optional Subtitle

Dissertation

for the purpose of obtaining the degree of doctor
at Delft University of Technology

by the authority of the Rector Magnificus, prof. dr. ir. T.H.J.J. van der Hagen,
chair of the Board for Doctorates

to be defended publicly on
[date= weekday (word) day (number), month (word) year (number)] at [hh:mm

(number)] o’clock

Check that
everything
here is cor-
rect RIGHT
BEFORE
SEND-
ING YOUR
THESIS TO
THE PUB-
LISHER

by

Albert EINSTEIN

[highest academic title, name university, country]
born in [town/city, country of birth]



This dissertation has been approved by the promotors.

Composition of the doctoral committee:
Rector Magnificus, chairperson
Prof. dr. A. Kleiner, Delft University of Technology, promotor
Dr. A.A. Aaronson, Delft University of Technology, copromotor

Independent members:
Prof. dr. A. Jansen Delft University of Technology
Prof. dr. ir. A.B.C.D. van de Lange-Achternaam

Delft University of Technology
Prof. dr. N. Nescio Politecnico di Milano, Italy
Prof. dr. ir. J. Doe, Delft University of Technology, reserve member

Other members:
Prof. dr. ir. J. de Wit, Delft University of Technology
Dr. ir. Q. de Zwart, Delft University of Technology

Prof. dr. ir. J. de Wit of Delft University of Technology has contributed greatly to the
preparation of this dissertation.

Keywords: . . .

Printed by: Johannes Gutenberg

Cover by: Beautiful cover art that captures the entire content of this thesis in
a single illustration.

Copyright © 2026 by A. Einstein

ISBN 000-00-0000-000-0

An electronic copy of this dissertation is available at
https://repository.tudelft.nl/.

https://repository.tudelft.nl/


Einstein’s work is to make physics more philosophical (in a good sense).

Hendrik Antoon Lorentz





Contents
Summary ix

Samenvatting xi

Preface xiii

Nomenclature xv
1. Latin capitals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xv
2. Latin lower case . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xv
3. Greek upper case . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xv
4. Greek lower case . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xv

1. Introduction 1
1.1. Document Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
1.2. Title Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
1.3. Chapters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

1.3.1. \subsection{. . . } . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
1.4. Fonts and Colors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
1.5. Roboto . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
1.6. Listings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
1.7. Citing literature . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
References . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

2. Conclusion 13

A. Plotting 15

B. LATEX quality assurance 17

Epilogue 19

Acknowledgements 21

Curriculum Vitæ 23

List of Publications 25

vii





Summary
Summary in English. . .

ix





Samenvatting
Samenvatting in het Nederlands. . .

xi





Preface
Preface goes here. This chapter is optional.

This is the TU Delft dissertation template for LATEX. The source files can be found
at GitLab1. It is designed to work with pdfLATEX and LuaLATEX, and produce output
adhering to the TU Delft corporate design style2.

The template can be used with Overleaf and supports the combination of Arial3
with Roboto Slab4 or Roboto5 with Roboto Slab. Besides, the font Utopia6 using the
LATEX package Fourier7.

Albert Einstein
Delft, April, 2026

1https://gitlab.com/novanext/tudelft-dissertation
2https://www.tudelft.nl/en/tu-delft-corporate-design
3https://en.wikipedia.org/wiki/Arial
4https://fonts.google.com/specimen/Roboto+Slab
5https://fonts.google.com/specimen/Roboto
6https://fonts.adobe.com/fonts/utopia
7https://ctan.org/pkg/fourier

xiii
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Nomenclature
This nomenclature uses the longtable environment to create a table that can
spread over multiple pages. Alternatively, Overleaf suggests using nomencl.1

1. Latin capitals

symbol units description
G m3 kg−1 s−2 Gravitational constant
T K Temperature

2. Latin lower case
symbol units description
g ms−2 Gravitational acceleration
p P Pressure
t s Time
 ms−1 Velocity

3. Greek upper case

symbol units description
Ω rd s−1 Angular velocity

4. Greek lower case
symbol units description
μ P s Dynamic viscosity
ρ kgm−3 Density

1https://www.overleaf.com/learn/latex/Nomenclatures

xv

https://www.overleaf.com/learn/latex/Nomenclatures




1
Introduction

Albert Einstein and H. A. Lorentz

Nature and nature’s laws lay hid in the night;
God said ‘Let Newton be!’ and all was light.

Alexander Pope

It did not last: the devil shouting ‘Ho.
Let Einstein be!’ restore the status quo.

Sir John Collings Squire

Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor
incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud
exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure
dolor in reprehenderit in voluptate velit esse cillum dolore eu fugiat nulla pariatur.
Excepteur sint occaecat cupidatat non proident, sunt in culpa qui officia deserunt
mollit anim id est laborum.

Parts of this chapter have been published in Annalen der Physik 324, 289 (1906) [1].

1



2 1. Introduction

This document is intended to be both an example of the TU Delft dissertation
template for LATEX, as well as a short introduction to its use. It is not intended to be
a general introduction to LATEX itself,1 and we will assume the reader to be familiar
with the basics of creating and compiling documents.

Instructions on how to use this template under Windows and Linux, and which
LATEX packages are required, can be found in README.txt.

1.1. Document Structure

S ince a dissertation is a substantial document, it is convenient to break it up into
smaller pieces. In this template we therefore give every chapter its own file.

The chapters (and appendices) are gathered together in dissertation.tex,
which is the master file describing the overall structure of the document.
dissertation.tex starts with the line

\documentclass{tudelft-dissertation}

which loads the dissertation template. The template is based on the LATEX book doc-
ument class and stored in tudelft-dissertation.cls. The document
class accepts several comma-separated options. By default, hyperlinks are shown
in cyan, which is convenient when reading the dissertation on a computer, but can
be expensive when printing. They can be turned black with the print option. This
will also turn the headers dark gray instead of cyan. Moreover, it will add a 3 mm
bleed around the page including crop marks. This will help the printer with the edge
indices, since they run right up to the page borders. Finally, the fourier option
can be used to override the automatic font selection (see below).

A dissertation is a big document, which makes it easy to miss warnings about the
layout in the LATEX output. In order to locate problem areas, add the draft option
to the \documentclass line. This will display a vertical bar in the margins next
to the paragraphs that require attention.

The contents of the dissertation are included between the\begin{document}
and \end{document} commands, and split into three parts by

1. \frontmatter, which uses Roman numerals for the page numbers and
is used for the title page and the table of contents;

2. \mainmatter, which uses Arabic numerals for the page numbers and is
the style for the chapters;

3. \appendix, which uses letters for the chapter numbers, starting with ‘A’.

The title page is defined in title.tex in the title folder and included
verbatim with \include{title/title},2 (see below). Additionally, it is
possible to include a preface, containing, for example, the acknowledgements. An

1We recommend http://en.wikibooks.org/wiki/LaTeX as a reference and a starting
point for new users.

2Note that it is not necessary to specify the file extension.

http://en.wikibooks.org/wiki/LaTeX
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example can be found in preface.tex. The table of contents is generated auto-
matically with the \tableofcontents command. Chapters are included after
\mainmatter and appendices after\appendix. For example,\include{
introduction/introduction} includesintroduction/introduction.tex,
which contains this introduction.

1.2. Title Page

T he title pages are defined in title/title.tex, which you will have to
modify according to your needs. Note that these pages are subject to the require-

ments of the promotieregelement and cannot be changed at will. The title page may
be written in the English or Dutch language; preferably in the same language as the
dissertation. Apart from the names and dates, most of the text is dictated literally.

Since the thesis title and name of the author appear several times throughout the
document (on the title page, but also in, e.g., the preface and cv), special commands
are provided so they only have to be specified once. The title (and optional subtitle)
can be specified with

\title[Optional subtitle]{Title}

The name of the author is specified with

\author[First name]{Last name}
Note that the first and last name are separate arguments, since they may be printed
in different font shapes. The \title and \author commands also ensure that
the title and author appear in the metadata of the final PDF when the package
hyperref is used.

See title/title.tex for detailed documentation on the comment and
layout of the title pages. Logos of institutes that have contributed financially to the
dissertation may be included on reverse side of the title page. A few example logos
can be found in the -logos folder.

1.3. Chapters

E ach chapter has its own file. For example, the LATEX source of this chapter can be
found in introduction/introduction.tex. A chapter starts with

the command

\chapter{Chapter title}

This starts a new page, prints the chapter number and title and adds a link in the
table of contents. If the title is very long, it may be desirable to use a shorter version
in the page headers and the table of contents. This can be achieved by specifying
the short title in brackets:

\chapter[Short title]{Verylongtitlewithmany
words which could not possibly fit on one line}
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The command \frontmatter sets page numbering to lower case Roman, and
removes the chapter numbering. \mainmatter sets both numberings to Arabic
(‘normal’) numbers. \appendix sets the chapter numbering to upper case Latin
letters. \backmatter removes the chapter numbering again.

If (parts of) the chapter have already been published elsewhere, it is customary to
add a reference. This can be done with the special unnumbered footnote command
\blfootnote. For example,

\blfootnote{Partsofthischapterhavebeenpublished
in Annalen der Physik \textbf{324}, 289 (1906)
\autocite{Einstein1906}.}

generates the footnote at the beginning of this chapter. Because this footnote is
unnumbered, the hyperref package may throw a warning, which safely be
ignored.

If multiple people have contributed significantly to this chapter, they can be
lister with the \authors command.3 This can be followed by a quotation us-
ing \epigraph as shown above. Finally, it is customary for a dissertation to
include an abstract for every chapter (except perhaps the introduction). This can be
accomplished with the abstract environment. The abstract should be followed
by \newpage to start the chapter text on a new page.

In a dissertation, each chapter has its own list of references. These can be gener-
ated with the special command\references{tudelft-dissertation}
from dissertation.bib at the end of the chapter. Note that this means that
you need to run a command like biber chapter-1/chapter-1 for each
chapter. The template will automatically generate clickable hyperlinks if a URL or
DOI (digital object identifier) is present for the reference. Although it is possible
to manage the bibliography by hand, we recommend using Zotero4, Mendeley5,
EndNote, or JabRef6.

Some common Dutch names don’t play well with the citing mechanisms of common
software. Take a look at the examples ’t Hooft [3] and Van der Waals [4] to get this
right in LATEX. To make this more confusing, the Flemish convention is to capitalise
these words and treat them like just like a regular part of the family name.

Von Kármán [5] has a name with a prefix, which should be capitalised at the start
of a sentence only (by using the capitalised command \Textcite). Later in the
sentence von Kármán [5] is not capitalised anymore.Fermat [6]

has a name
with prefix,
which is only
used when
the name
is used in-
cluding given
name.

Chapters are subdivided into sections, subsections, subsubsections, and, op-
tionally, paragraphs and subparagraphs. All can have a title, but only sections and
subsections are numbered.

fix

Sometimes, you may want to use math in the sectioning headings. To make this
math appear bold whenever the heading text is bold (as in the heading right above),

3Van de Lange-Achternaam [2] would be disappointed if his contribution were not acknowledged.
4Open source, desktop and online version available from https://www.zotero.org
5Desktop and online version available from https://www.mendeley.com/
6Open source, specialised ⁎.bib file editor; desktop only, available from http://jabref.
sourceforge.net/

https://www.zotero.org
https://www.mendeley.com/
http://jabref.sourceforge.net/
http://jabref.sourceforge.net/
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you can use the following document class option:
\documentclass[headingMathBold]{tudelft-dissertation}
If you use bold math with a meaning (e.g. vectors) this could be confusing, in which
case you better remove the document class option:\documentclass{tudelft-dissertation}

1.3.1. \subsection{. . . }
\subsubsection{. . . }
\paragraph{. . . } Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do
eiusmod tempor incididunt ut labore et dolore magna aliqua. Ut enim ad minim
veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo
consequat. Duis aute irure dolor in reprehenderit in voluptate velit esse cillum dolore
eu fugiat nulla pariatur.

\subparagraph{. . . } Excepteur sint occaecat cupidatat non proident, sunt in
culpa qui officia deserunt mollit anim id est laborum.

1.4. Fonts and Colors

T he fonts used by this template can be chosen via a documentclass option. If you
leave the option (as given in the template) \documentclass[fourier]

{tudelft-dissertation}, Latex will use Utopia for titles and the main
text, Fourier for math, and Latin Modern for sans-serif and monospaced text.
If, on the other hand, you remove this option and use \documentclass{
tudelft-dissertation}, you will get Roboto Slab for titles, Roboto or
Arial for the main text, and sans-serif math as well. This is in line with the current
Corporate style of the TU Delft.

This template supports the use of drop caps, a large colored initial at the beginning
of a chapter or section, via the \dropcap command:

\dropcap{L}{orem} ipsum...

The first argument is the capital that will be printed on two lines (in the title color),
and the second argument is the rest of the word. Depending on the font, the latter
may be printed in small caps.

The corporate colors of the TU Delft are cyan, black and white, available,
respectively, via \textcolor{tud primary}{...}, \textcolor
{black}{...} and \textcolor{white}{...}. Apart from these
three, the house style defines the following basic colors, that can be used via
\textcolor{tud colorname}{...}:

• navy
• topaz
• blue

• purple
• pink
• shiraz

• grapefruit
• orange
• yellow

• green
• teal
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ISO 80000 [7] defines that in mathematical typesetting, only variables should be
italised. This means that constants (numbers, units, functions such as J0, sin etc.)
and other text should be upright. A more accessible source for these typesetting rules
is the SI brochure [8, §2.3.1]. A few examples of correctly typeset math are shown
below. The packages siunitx and amsmath (here loaded via mathtools)
makes typesetting math correctly significantly easier.

The rotational speed of the earth around the sun is approximately Ωearth =
2π rdyer−1 ≈ 0.1991µrd s−1.7

The unnormalised sinc function is defined as follows:

sinc =

¨

0 where  = 0
1/ sin else

(1.1)

The following equation, commonly known as Euler’s identity, consists of constants
numbers only, and hence all symbols should be set upright:

eiπ + 1 = 0 (1.2)

Here’s a nice equation used as a demo by the LATEX font catalogue8

B(P) =
μ0

4π

∫ I× r̂′

r′2
d =

μ0

4π


∫

dl × r̂′

r′2
(1.3)

We would like to acknowledge Kelvin [9] for his nice temperature scale, and the
challenge posed by citing his name in a sensible manner. Furthermore, we would
like to take a moment to appreciate this beautiful equation, unrelated to table 1.1:

ρ
D

Dt
= ρ

�

∂

∂t
+  · ∇
�

= −∇p̄ + μ∇2 + 1
3μ∇(∇ · ) + ρg

1.5. Roboto

T he TU Delft style prescribes Roboto Slab together with Arial.9 You are free to
either use Arial (TEX Gyre Heros10 when using PdfLATEX) using the class option

usearial; else regular Roboto is instead.11 Not surprisingly, this also looks great
together with Roboto Slab. In any case, this section is typeset using Roboto.

Roboto (Sans) has a dual nature. It has a mechanical skeleton and the forms
are largely geometric. At the same time, the font features friendly and open curves.

7In TEX, math mode is toggeled using $...$, which is still what many people use. In LATEX, we can
do this too, but we can also use a clear beginning and end of math mode, as \(...\), which will
make your code and possible error messages easier to understand.

8https://tug.org/FontCatalogue/
9https://www.tudelft.nl/huisstijl/bouwstenen/typografie

10https://ctan.org/pkg/tex-gyre-heros
11Some significant differences between these otherwise very similar fonts are shown here: http:
//www.identifont.com/differences?first=Arial&second=Roboto

https://tug.org/FontCatalogue/
https://www.tudelft.nl/huisstijl/bouwstenen/typografie
https://ctan.org/pkg/tex-gyre-heros
http://www.identifont.com/differences?first=Arial&second=Roboto
http://www.identifont.com/differences?first=Arial&second=Roboto
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Table 1.1.: Modern values for Planck’s original choice of quantities from
https://en.wikipedia.org/wiki/Planck_units

Quantities Expression (Approximate) value units

length P =
r

ℏG
c3

1.616 × 10−35 m

mass mP =
Ç

ℏc
G 2.176 × 10−8 kg

time tP =
P
c =

ℏ
mPc2

=
r

ℏG
c5

5.391 × 10−44 s

charge qP =
p

4πϵ0ℏc 1.876× 10−18 C

temperature TP =
mPc2

kB
=
s

ℏc5

Gk2B
1.417 × 1032 K

While some grotesks distort their letterforms to force a rigid rhythm, Roboto doesn’t
compromise, allowing letters to be settled into their natural width. This makes for a
more natural reading rhythm more commonly found in humanist and serif types.

Roboto Serif is designed to create a comfortable and frictionless reading experi-
ence. Minimal and highly functional, it is useful anywhere (even for app interfaces)
due to the extensive set of weights andwidths across a broad range of optical sizes.
While it was carefully crafted to work well in digital media, across the full scope of
sizes and resolutions we have today, it is just as comfortable to read and work in
print media.

Roboto has several styles of digits:

• ‘Normal’ lining numbers

– Proportional: 1234567890

– Tabular: 1234567890

• Old-style numbers

– Proportional: 1234567890

– Tabular: 1234567890

Furthermore, the font is available in many different weights:

• Roboto Thin
• Roboto Light

• Roboto Regular
• Roboto Medium

• Roboto Bold
• Roboto Black

Finally, RobotoFlex is a variable font with many ‘axes’ for customisation, allowing
for very fancy variation12. These features are well supported by the LuaLATEX pack-
age fontspec13.

12https://fonts.google.com/specimen/Roboto+Flex/about
13https://latex3.github.io/fontspec/fontspec.pdf#page=34

https://en.wikipedia.org/wiki/Planck_units
https://fonts.google.com/specimen/Roboto+Flex/about
https://latex3.github.io/fontspec/fontspec.pdf#page=34
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1.6. Listings

Y ou can add programming code using “Insert » Program Listing”. To include a
listing from an external file, use “Insert » File » Child Document. . . ” and pick

“Program Listing” from the dropdown menu (“Type”). Here is an example:

import math

def exp(x):
return math.e ⁎⁎ (x)

# check whether Euler was right:
assert abs(exp(1j ⁎ math.pi) + 1) < 1e-12, "Euler was wrong."

This specific bit of code checkswhether the Euler identity is correct. The following
bit of code is used to generate Figure 1.1, showing a mass–spring system.

\documentclass[tikz]{standalone}
\usepackage{siunitx}
\begin{document}
\begin{tikzpicture}
% https://tex.stackexchange.com/questions/41608/
% draw-mechanical-springs-in-tikz

\usetikzlibrary{decorations.pathmorphing,patterns}
\usetikzlibrary{calc,patterns,decorations.markings}
\usetikzlibrary{positioning}

\draw[thick] (-2, 2.5) -- (2, 2.5);
\foreach \x in {-1.8,-1.5,...,1.8}

{\draw (\x, 2.5) -- ++(.3, .3);}

\begin{scope}[thick,decoration={
coil, pre length=1.5mm, post length=1.5mm,
segment length=2mm, amplitude=10,aspect=.3

}]
\draw[decorate] (-1,2.5) -- ++(0,-1.5)

node[pos=.5, left=4mm] {$k$};
\draw[decorate] (1, 2.5) -- ++(0, -1.5)

node[pos=.5, left=4mm] {$k$};
\end{scope}

\node[blue, very thick, draw=orange, fill=yellow,
minimum height=14mm, minimum width=32mm]

at (0, 3mm) {\SI{100}{kg}};

\end{tikzpicture}
\end{document}
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The language used in this code fragment is documenten on https://tikz.
dev/. More examples can be found on https://tikz.net/. A more in-
volved figure is shown in fig. 1.2.

k k

100 kg

Figure 1.1.: This figure shows a schematic representation of a mass–spring system.

Input

• [step 0]

• [step 1]

• [step 2]

Older
Data

Converged?

Done

Figure 1.2.: A flowchart created with TikZ

The figure can also be rendered on its own using the documentclass and pack-

https://tikz.dev/
https://tikz.dev/
https://tikz.net/
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age standalone.14. To make working with TikZ easier, the ‘standalone’ version
adds some other helpful features like a background grid, and showing the names
of nodes.

1.7. Citing literature
Within the dissertation, references are listed per chapter. This is done by encapsulat-
ing every chapter between\begin{refsection}and\printreferences
\end{refsection}.

Missing citations are shown by their label in bold, with a double questionmark, so
that searching for double questionmarks gives all missing references and citations.
You can try that out by misspelling the argument of the following command: Van de
Lange-Achternaam [2]

Bibliographies may look sloppy when urls stick out into the margin because LATEX
is not able to decide where to break them across lines. If this happens, you may
have a look at the packagesbreakurl orxurl. Youmay also have a look at the
biblatex documentation and search for the counterbiburlnumpenalty.
Foreign words may also be a challenge to hypehate correctly. You can use the com-
mand \hyphenation to tell LATEX how to hyphenate a word, or add optional
hyphens (e.g., hy\-phens).
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https://doi.org/10.1017/cbo9780511996009.040




2
Conclusion

The mathematician’s patterns, like the painter’s or the poet’s must be beautiful; the
ideas, like the colours or the words must fit together in a harmonious way. Beauty is

the first test: there is no permanent place in this world for ugly mathematics.

G. H. Hardy, A Mathematician’s Apology (London 1941)
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14 2. Conclusion

This chapter has a two-page graphic spanning both the (right) page showing the
chapter title and the (left) one right before. This is done by either one or both of the
commands

• \LeftOpener[x-position,y-position]{contents} and/or

• \RightOpener[x-position,y-position]{contents}.

This is a concluding chapter explaining the scientific and technical implications for
society of the research findings in considerable detail. We would also like to remind
the reader of our outstanding results, visualised elegantly in fig. 2.1. This reference
was inserted using the package ‘cleveref’.

Furthermore, we want to boast about the relevance to society. A list of of all‘todonotes’
like these
can be used
to keep track
of unfulfilled
ambitions.
If not all
ambitions
are fulfilled
before the
document
is handed
in, they can
be hidden
in the final
version by
adding the
document
option ‘final’.

todonotes can be generated (preferably at the very end of the document) using the
command \listoftodos. If you want to include more than just a few words of
computer code, it is highly recommended to use either the package listings
or minted to get syntax highlighting, amongst others, instead of the command
\verb.

pick posterchild graphic

Missing
figure

Figure 2.1.: This graphic compellingly sums up my research.



A
Plotting

The appearance of plots in Matplotlib can be customised by using style sheets:
https://tonysyu.github.io/raw_content/matplotlib-style-gallery/
gallery.html

0 2 4 6 8 10

4

6

8

10

12

14

16

measurement model confidence

Figure A.1.: Confidence band demo.

As mentioned by wikipedia1, Utopia can be downloaded in *.otf, *.ttf and other
formats for free:

• https://ghostscript.com/~tor/stuff/fonts/utopia/
or

1https://en.wikipedia.org/wiki/Utopia_(typeface)
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16 A. Plotting
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Figure A.2.: Histogram in the upper pane; Bar chart in the lower pane.

• https://code.google.com/archive/p/evristika/.

These fonts can be read directly by matplotlib, but cannot be used in mathtext. The
font Stix blends in decently, but better (though slower) is using latex to typeset math
in matplotlib. Comments in the matplotlib style file show how this could be done.

https://code.google.com/archive/p/evristika/


B
LATEX quality assurance

Before handing your work over to others, there are a few things you can do as a
basic quality assurance (QA):

• Check your output for missing references (indicated by a double question mark,
you may use pdftotext to automate this) or look at the blg and log files,
where these will be indicated as well

• Use a spelling checker
– Overleaf checks your spelling by default.
– In TEXstudio you can set the spelling check at:

TEXstudio Options→ Configure TEXstudio. . .→ Language Checking.
– You can use Aspell (http://aspell.net/) to check the spelling

in *.tex files from the command line.
– If all else fails, you can open a tex file in MS Word and use their spelling

and grammar checker

• Check consistency of capitalisation in the table of contents

• Consistency in bibliography
– Capitalisation of titles
– Notation of author names
– Abbreviation and spelling of journals
– Some Dutch names are capitalized differently depending on wether they

are preceded by initials or given names.1 For this, you may use the biblatex
command \autocap. The same holds for Arabic names, but not, for
instance Belgian or German.

• Search through your code for words you have likely misspelled (or mix British
and American spelling)

1https://onzetaal.nl/taalloket/hoofdletters-namen-nederland
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18 B. LATEX quality assurance

– In Windows: ls -R ⁎.tex | sls 'teh'
– In Linux: grep -iR 'teh' ⁎.tex
– In Apple: grep -i 'teh' ⁎⁎/⁎.tex

• You can also search for regular expressions (regex), e.g.:
– "\s[\"']\w" (grep) or'\s[''"]\w' (sls): A space, newline, etc.

followed by closing single or double quotes, followed by a word character
(e.g. a letter). Most likely, these should be replaced by opening quotes (‘
or “).

– "\b(\w+) \1\b" repeated word
– "\b[A-Z][A-Z]+[a-z]" word starting with two capitals
– In your *.bib files:
⋄ "author\s⁎=.⁎\w\.\w" initial without following space.
⋄ "author\s⁎=.⁎\b\w\s\w" initial without following period.
⋄ "url\s⁎=.⁎doi" DOI given as URL instead of DOI directly
⋄ "doi\s⁎=.⁎doi\.org" DOI including ‘doi.org’
⋄ "[Uu]rl.⁎[^\\]#" Forgot to escape # in URL

– Depending on your citation style:
⋄ space before cite
⋄ no space before cite
⋄ parenthesis around cite
⋄ no parenthesis around cite
⋄ . . .

– grep -rnPiR "[^\x09\x0D\x20-\x7E\xBF-\xFF]" ⁎.tex
(or
⁎.bib ‘weird’ characters (that may look normal) probably caused
by copying something from the a pdf file, which might cause LATEX to error.

– When not using ’french spacing’: patterns which likely confuse periods
indicating an abbreviation with end of sentence and vice versa.

• Check your output for missing references (indicated by a double question mark,
you may use pdftotext to automate this) or look at the log files, where
these will be indicated as well

• ChkTEX (https://www.ctan.org/pkg/chktex) is written spe-
cifically to search for common errors in *.tex files

• All of these suggestions work best when automated, for instance in a Makefile.
Doing it by hand is way too boring, so you are very likely to forget running some
of these tests on the final version of your thesis.

https://www.ctan.org/pkg/chktex


Epilogue
This is an optional epilogue.
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